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3 THANK YOU! 

3 A NEW EVENT @ 1740 

A Peek Inside the Mind of Lady Tie 

 

You just did a scene; the sub is on the cross 

and lost in subspace… As the Top what do 

you do next? You do aftercare.  

Each person will need something a bit 

different and that is why you should 

negotiate this before doing a scene. The sub 

will have all those wonderful endorphins 

running in their blood and when the 

stimulation of the scene stops the 

endorphins start to ease off also. This can 

cause many responses. Things like 

becoming cold, thirsty, giggly, teary, quiet, 

weak, and cuddly. As the top in the scene it 

is your job to deal with these. You also 

have to remember often a scene will cause 

the sugar in a person blood to drop so that 

it is low, chocolate or a sweet is a good 

thing to follow a scene with, but make sure 

they can eat it without choking.  

CALENDAR OF EVENTS – MARCH 

MARCH 4 – Wichita First Friday Munch 
MARCH 5 – Private Rental 
MARCH 12 – Demo & Dungen Night 
MARCH 18 – Sub Spaced 
MARCH 19 – Members Night 
MARCH 25 – Freaky Friday 
MARCH 26 – WOOLF Event 
 
For our Demo this month… 
Daddy Matt, President of WOOLF, will 
present his class about flogging.  This will 
include some historical relevance as well as 
hands-on.  If you have an interest, either as 
a Top or bottom, this class is for you!  And 
don’t worry if you do not have a flogger to 
bring – we’ll make sure you get plenty of 
opportunities to try one out. 
 
For our Demo in April… 
Wichita Instructional Leather Doms (WILD) 
will present a class on BDSM vs Leather.  
This will include information on origins, 
protocol, and more.   
 
Our May Demo… 
Will include a cook out and round-robin 
fetishes.  WTF???  Eat, try out a fetish, eat 
some more, try another fetish, ask 
questions, try some more…get this picture?  
This was great fun last fall, so we are doing 
it again as a spring warm-up.  Stay tuned 
for more information by email and WP. Ω 

continued on page 2 
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This is an important step in making the 

scene a good one. If you’re the top, it is 

your duty to make sure your sub is safe 

and gets what they need. I personally like 

to stay within an arms length of a sub until 

I know they are ok. When I do after care it 

is for me as well as the sub. It lets me 

know we are still friends and they care 

about me after I just caused them pain. 

While I let them know I care about them 

even though I caused them pain. I 

personally fight a level of guilt when the 

scene is done and especially when the 

person’s emotional response to the scene is 

tears. I need to know they are emotionally 

ok and that our connection is still there and 

strong. I also need to let them know I care 

about them. I want to help ease them back 

to a calm mental state.  

If you’re a sub, you might need cuts and 

scrapes tended, some water, a snack, a 

warm blanket, a quiet place to rest. These 

are things you need to help you get your 

mental state back to a normal one.  It is 

good for you to know what you will need, 

make sure you tell the top what that is. If 

you don’t know what you will need, let 

them know you are not sure what you will 

need and ask them to be prepared for an 

unknown response.   

Some people may need to be left alone; 

they will take care of their own needs. But 

this is something you need to talk about 

before you play so you know what your 

partner will need. 

I personally like to keep in touch with the 

sub for a few days just to check in and 

make sure they are doing ok. I also like to 

get their thoughts on the scene, did they 

enjoy this or did it just not work the way 

they wanted it to. I want to make sure they 

feel good about our scene. This is a great 

way to help deal with sub drop if needed. 

But that is another article. Ω 

 

ADDITIONS TO OUR STAFF 
The board would like to announce the 

appointment of two of our members to the 

positions of Editor and WebMistress.   

 

Beautiful Shifter has been selected as the 

editor of The Whipping Post.  Her 

experience and education will help to raise 

the bar on our club’s newsletter.  You will 

see her work beginning with the April 

edition.   

By the time this edition is printed, Lisa 

will have begun to revise the 1740 

websites.  She appeared before the board to 

present ideas and suggestions for a 

revamp.  The board agreed that she was the 

right person for the job.   

You may look forward to seeing their work 

right away.  But, be sure to offer your 

words of encouragement as they offer their 

time and experience in these two important 

areas of communication. 

Krazzy Ray was our previous webmaster, 

and we are indeed grateful for his work 

and commitment.  He volunteered an 

enormous amount of time to set up our 

sites.  As mentioned in the last edition of 

WP, Star got the newsletter up and 

running.  We found that, while it is 

important to have, it is sometimes a bear to 

publish.  Thanks again to Star for her 

dedication to getting the job well done. Ω 

 

 

And in the end it's not the years in your life 

that count.  It's the life in your years.   

--Abraham Lincoln 

 

 

We are looking forward to The Whipping 

Post has become an excellent source of 

information and education for the 1740 

continued from page 1 
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T HA NK  Y OU!  

The board would like to take this 

opportunity to thank Nemesis for more 

than a year of service on the board and to 

1740.  His dedication, commitment, blood, 

sweat, and tears helped to make our club 

and family what we enjoy today.   

Nemesis has made the difficult decision to 

step off of the board.  His grounded 

thoughts and words of wisdom will truly 

be missed.  Thank you, Nemesis, for all 

you have done! Ω 
 

I LIKE IT IN THE CAN! 

Our first community fund raiser is going 
strong!  I Like it in the Can is a nation-
wide effort to encourage members of the 
BDSM/Leather community to contribute 1 
item per month toward a local food pantry.  
Our pantry items will be sent to First 
Metropolitan Community Church @ 156 
S. Kansas.  MCC has a long tradition of 
outreach to those who find themselves 
without enough food or daily essentials.  
Anyone, regardless of 1740 membership 
status, may take a valid ID or recent utility 
bill (in their name) to the food pantry on 
Tuesdays between 1-6pm and receive 
assistance.  Ω 

 

The 1740 Board 
 

Sir Darren, President 
 

Dr. Nukem, Vice President 
 

Christina, Secretary 
 

Lady Tie, Treasurer 

Board Member, OPEN 

 

 

 

 

 

TOTALLY BOOTS 

 
Wichita Organization Of Leather Fetishes, Inc. 

will be utilizing the 1740 Club House on March 

26
th

 as they host the 2
nd

 annual Totally Boots.  

This event is dedicated and planned for the boot 

enthusiast.  Presenters from Texas, Chicago, St 

Louis and Kansas will demonstrate boot 

blacking techniques, boot worship, and more.  

This is considered a private event, but 1740 

members are always welcome to register @ 

www.woolfks.com  (if you plan to attend their 

play party you need to register for that, too).  Ω 

 
 

NOTICE 

 
We are looking for members to volunteer, 

work with the board, and head a  com-

mittee.  The committees we are working on 

right now are: 

Concessions: This person will need to 

maintain inventory, train and supervise 

volunteers as well as develop the menu for 

WFFM. 

 

Housekeeping and Hospitality: This 

person will assure that the club house is 

clean, clean dungeon equipment during 

events, and show people around and 

encourage them to get to know others.  

 

These positions will have rewards as well 

as responsibilities. If you are interested or 

have questions please let the board know 

with a letter of intent.   You may send that 

to board@seventeenforty.com.  Thank 

you for considering these positions. Ω 

 

 
 

 

 

 

 

 

 

http://www.woolfks.com/
mailto:board@seventeenforty.com
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M O R E  W A Y S  T O  C U S T O M I Z E  T H I S  

T E M P L A T E  

FOOTERS 

To change the text at the very bottom of each page of your 

newsletter, click Headers and Footers on the View menu. 

Use the Header and Footer toolbar to open the footer, and 

replace the sample text with your own text. 

INSERT SYMBOL 

It is a good idea to place a small symbol at the end of each 

article to let the reader know that the article is finished and 

will not continue onto another page. Position your cursor at 

the end of the article, click Symbol on the Insert menu, 

choose the symbol you want, and then click Insert. 

Inserting and Editing 

Pictures 

Type your sub-heading here 

You can replace the pictures in this template with your 

company’s art. Select the picture you want to replace, 

point to Picture in the Insert menu, and click From File. 

Choose a new picture and then click Insert. Select the 

Link to File box if you don’t want to embed the art in 

the newsletter. This is a good idea if you need to 

minimize your file size; embedding a picture adds 

significantly to the size of the file. 

To edit a picture, click on it to activate the Picture 

toolbar. You can use this toolbar to adjust brightness 

and contrast,  

Choose a new picture, and click the Link to File 

box if you don’t want to save the art with the 

newsletter. 

change line properties and crop the image. For more 

detailed editing, double-click on the graphic to activate 

the drawing layer.  

HEALTH AND WELLNESS 

 HYDRATION:  Drink plenty of 
water (not that there is anything 
wrong with our coffee!) before 
starting a scene.  This is equally 
important for the top and the 
bottom. 

 STRETCH:  Warm up first!  Some 
simple stretching exercises before 
you throw your floggers may just 
keep you from throwing out your 
shoulder!  This may look funny to 
you, but it really is a good idea. 

 REST:  At some point, you have to 
get away from the computer and 
actually SLEEP.  Getting a good 
night’s rest will keep you mentally 
focused when it comes time to plan 
and prepare your scene. 

 DIET:  Yes, I said the D word.  A 
balanced diet may help you keep 
that mental focus, too.  If you are 
constantly feeling sluggish, you 
may need to rethink what you are 
putting in the ol’ fuel tank. 

Always consult a physician, banker, or 
attorney before you do anything that 
might lead to physical injury! Ω 

WE ARE LOOKING FOR IDEAS 

 

The board is seeking ideas and input for 
our own “signature” event.  This event (not 
our NYE party or the Halloween party) 
would be a fund raiser for us each year.   

 

We would love to have your ideas.  Please 
send them to us via comment card, carrier 
pigeon, or better yet – talk to one of us! 

 

Even if you think your idea is not a good 
one, the less-than-stellar ideas frequently 
lead to BRILLIANT ones.   

 

Why do we need to have a fund raiser?  
Some of the projects we/you want to 
undertake require a little more capital than 
we have on-hand.  For example, new 
dungeon furniture is not cheap (Dungeon 
Mart – Wichita went out of business).  
$500 would get us a very nice piece of 
equipment to add to our facility. 

 

Please, take the time and offer us your 
suggestions.  thanks! Ω 

 

Sub Spaced 

The newest 1740 evening will start in March.  Sub Spaced is for those who identify as 

sub/slave/switch (in bottom mode) or those who are unsure to get together and share 

experiences, knowledge and support. This group will be open to those who have been in 

this for a day or their entire life. We will also welcome some Doms to attend for silent 

learning experience, with a question section for them, however this is an experiment.  The 

focus is on the sub’s needs and wants.  This will be the first of our monthly meetings; we 

are going to be doing some get-to-know each other conversations, sharing experiences, 

starting on our sub drop web and a few other things.  

So come and join us and bring your thoughts, questions and concerns to share in a relaxed 

environment. 

If you are interested contact Lady Tie here or on Fetlife.com (LadyTie) Ω 
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